
SCARM 
Simple Computer Aided Railway Modeller 

Ver. 0.9.x beta 

SCARM significa Simple Computer Aided Railway Modeller – un software gratuito per la progettazione semplificata di layout 
ferroviario in scala e la creazione di tracciati ferroviari modello. Con SCARM è possibile creare facilmente il layout desiderato - 
basta scaricare il pacchetto di installazione ed iniziare a modificare il primo tracciato. Segue una breve descrizione sull'uso del 
programma nella sua fase attuale di sviluppo sotto. Invia le tue domande, commenti, recensioni o critiche su SCARM, nella pagina 
ufficiale di Facebook o tramite indirizzo  e-mail (in lingua inglese). 

E non dimentichiamo - la cosa più importante è divertirsi :) 
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Download  

Dopo l'installazione, avviare il programma e selezionare la lingua desiderata dal menu "View" > "Language". 

 

Immagini  

1. Sample0_TT.zip - TT (1:120), 1530mm x 730mm (60.2" x 28.7"), 9 KB (106 KB unzipped) 

             

2. Sample1_HO.zip - HO (1:87), 3760mm x 1500mm (148" x 59"), 35 KB (595 KB unzipped) 

      
      

Mi piace 273

 SCARM v. 0.9.17 Multilingua  - 1.54 MB, dal 22.08.2012 

Requisiti di 
sistema: 

Windows 2000/XP/Vista/7 
Grafica compatibile OpenGL

Tipo di 
installazione: Programma di installazione standalone

Lingue:             
    

Licenza: Gratuito

  



             

 

Lingue e traduzioni  

Se la lingua non è presente, ma si conoscono alcune delle altre lingue incluse, è possibile tradurre l'interfaccia utente utilizzando 
SCARM "Strumenti" > "Wizard per la traduzione" del menu e inviare il file di traduzione all'autore per l'integrazione nel pacchetto di 
installazione. 

Se si desidera tradurre anche la documentazione per SCARM nella propria lingua, contattare l'autore  per 
ricevere file di testo e le istruzioni per la traduzione. 

L'autore di SCARM sarà molto grato a tutti quelli che, lo stanno aiutando con la nuova traduzione o con correzioni e aggiornamenti 
per le traduzioni esistenti. 

 

Storia della versione   
 
mostra tutti / nascondi intermedio 

20.05.2010 – Prima versione di SCARM
04.09.2011 – 0.9.0 

Added functionality: 
- 2D/3D figures and shapes for creating buildings, platforms, roads, etc. 
- 2D/3D predefined objects for placing signals and other railway/scenery related items 
- Toolbox window with several functional tools 
- Export to EMF files (experimental) 
- Fullscreen mode in 3D Viewer 
- Context menu in 3D Viewer 
- Several keyboard shortcuts for fast switching of some visual settings and measurement units 
Improved turntables management 
New & updated libraries 
Italian documentation (thanks to Fabio Cuccia) 
Bugfixes 
- Fixed bug on start when there is no printer installed

09.09.2011 – 0.9.1 
Added functionality: 
- Improved Rotation dialog box 
Updated translatios (French, Italian, Russian) 
Bugfixes 
- Fixed bug when showing Parts list

14.09.2011 – 0.9.2 
Added language: 
- Spanish (thanks to Ramon Paradell & Matias Ibarra) 
Updated translation (German) 
Bugfixes

22.09.2011 – 0.9.3 
Added functionality: 
- New tool for simplified creation of rectangular baseboard in the Toolbox  
Corrections and updates in many track libraries 
Corrections in the language translations 
Bugfixes

02.10.2011 – 0.9.4 
Improved Status bar 
Corrections and updates in many track libraries 
Bugfixes

30.10.2011 – 0.9.5 
Added functionality: 
- 1:1 zoom factor for exact printouts 
- User-defined track colors 
Updated translation (Dutch) 
Bugfixes

03.11.2011 – 0.9.6 
Added language: 
- Danish (thanks to Carsten Jensen) 
Corrections and updates in many track libraries 
Bugfixes

13.11.2011 – 0.9.7 
Added language: 
- Czech (thanks to Jakub Svozil) 
Corrections and updates in many track libraries 
Bugfixes

19.11.2011 – 0.9.8 
Added language: 
- Romanian (thanks to Vasile Surducan)

22.01.2012 – 
0.9.9 
Added functionality: 
- Drag&Drop feature for tracks and objects (from selection panel to drawing plot; experimental)
- Parallel Start point function (in Edit menu) 
- Selection by List function (in Tools menu) 
Added language: 



 

Che cosa è in grado di fare SCARM?  

� Disegnare una ferrovia in scala con i seguenti sistemi binari (librerie):* 
- Aristo-Craft G EU Brass 
- Aristo-Craft G US Stainless Steel 
- Aristo-Craft G US Brass 
- Arnold N 
- Atlas HO Snap-Track C100 
- Atlas HO Snap-Track C83 
- Atlas HO True-Track C83 
- Atlas N C80 
- Atlas N True-Track C65 
- Atlas N C55 
- Atlas O 2-rail C148 
- Atlas O 3-rail 
- Atlas O Industrial 
- Bachmann G Large Scale 
- Bachmann HO EZ Nickel-Silver 
- Bachmann HO EZ Steel 
- Bachmann N EZ Nickel-Silver 
- Bachmann OO Branchline 
- Bemo HOe 
- Bemo HOm Standard 
- Bemo HOm Model C70 
- ETS O 
- Fleischmann HO Model 
- Fleischmann HO Profi  
- Fleischmann N Piccolo 
- Fleischmann ТТ (piatto unico) 
- Frateschi HO 
- Hornby OO  
- Hornby OO Dublo 2-rail  
- Hornby OO Dublo 3-rail   
- Kato HO Unitrack 
- Kato N Unitrack (senza ponti e viadotti) 
- Kleinbahn HO 
- Kuehn TT 
- Lenz O 
- LGB G 
- Lionel G Add-on pack 
- Lionel O 

- Hungarian (thanks to Gabor Bejczi) 
Russian documentation (thanks to Igor Zagrubskii) 
Corrections and updates in many track libraries 
Bugfixes

23.01.2012 – 0.9.10 
Bugfixes 
- Fixed English language file, due to some mismatched text translations

31.01.2012 – 0.9.11 
Updated translations (Italian, Danish, Romanian)

03.02.2012 – 0.9.12 
Bugfixes 
- Fixed EConvertError on startup that may appear on some machines

09.02.2012 – 0.9.13 
Updated translations (German, Spanish, Hungarian)

25.02.2012 – 0.9.14 
Added language: 
- Greek (thanks to Ioannis Mpekes) 
Corrections and updates in many track libraries

16.03.2012 – 0.9.15 
Added language: 
- Portuguese (thanks to Carlo Bacchiocchi) 
German documentation (thanks to Ingo Imcke) 
Corrections and updates in many track libraries 
Bugfixes

30.06.2012 – 0.9.16 
Added functionality: 
- Text entering feature (experimental) 
Added language: 
- Brazilian Portuguese (thanks to Juan Jurado) 
Updated translations (Dutch, Czech) 
Added some US position & color light signals 
Corrections and updates in many track libraries 
Bugfixes

22.08.2012 – 0.9.17 
Added functionality: 
- Zoom factor field in the Status bar 
Added language: 
- Swedish (thanks to Magnus Dahlgren) 
Updated translations (Hungarian, Italian, Romanian) 
Bugfixes



- Lionel O FasTrack 
- Lionel O27 
- Märklin HO C 
- Märklin HO K 
- Märklin HO M  
- Märklin I 
- Märklin Z 
- Microtrains Z Micro-Track 
- Peco G C250 
- Peco HO/OO Streamline & Set-track C100 
- Peco HO Streamline C83 
- Peco HO/OO Streamline C75 
- Peco HOe/OO9 C80 
- Peco I C200 
- Peco N Streamline & Set-track C80  
- Peco N Finescale C55 
- Peco O Flat-Bottom C143 
- Peco O Bullhead C124 
- Peco Oe/O16.5/On30 C100 
- Peco Z C60 (flex binaro) 
- PIKO G 
- PIKO HO A 
- PIKO HO Standard  
- PIKO N  
- Roco HO GeoLine 
- Roco HO Line 
- Roco HOe 
- Roco N 
- Roco ТТ (piatto unico) 
- Rokuhan Z 
- Tillig HO Elite 
- Tillig HO Standard 
- Tillig TT Bedding 
- Tillig TT Model 
- Tillig TT Standard (BTTB)   
- Trix HO C 
- Trix N Minitrix 
- Walthers HO Cornerstone (piatto unico) 
- Walthers HO Shinohara C83 
- Walthers N Cornerstone (piatto unico) 
* Alcune delle librerie non sono del tutto complete. L'accuratezza dei dati non è garantita. Altre librerie arriveranno presto.  

� Mostrare con vista 3D la linea ferroviaria progettata  

 

Perché, in generale, utilizzare SCARM?  

� Perché è facile e divertente e può essere molto utile  
� Perché SCARM ha un'interfaccia utente intuitiva e leggera, che è descritta nella FAQ qui sotto  
� Perché è GRATUITO e ha tutto il necessario per cominciare a pianificare il layout della ferrovia dei nostri sogni :)  

 

Come iniziare?  
 
Ad esempio, si può iniziare con un semplice ovale: Avviare il programma (scarm.exe) e selezionare "Modifica" > "Nuovo Punto di 
Partenza" dal menu principale. Fare clic con il tasto sinistro del mouse per posizionare il punto di partenza sulla trama. "Tillig-TT-
Std" è la biblioteca selezionata per impostazione predefinita. Selezionare direttamente il binario #6110 dal pannello verticale a 
sinistra (usando il tasto sinistro del mouse). Quindi selezionare una curva #6210 nello stesso modo - appariranno pulsanti 
aggiuntivi per la direzione – scegliere la direzione desiderata e cliccare su uno di loro. Per ripetere l’inserimento del pezzo curvo, 
premere la barra spaziatrice 3 volte fino a formare sul terreno un semicerchio. Se alcuni pezzi vanno fuori dell'area visibile del 
tracciato, utilizzare la rotellina del mouse per ridimensionare il disegno o premere per spostare l'area di disegno nella direzione 
desiderata (si possono usare i tasti freccia). Poi piazziamo di nuovo il binario #6110 seguito da 4 curve #6210 e il vostro primo 
ovale è pronto. Le estremità del circuito saranno collegate tra di loro automaticamente, perché le loro estremità si sovrappongono 
nello stesso punto. 

Guida introduttiva come realizzare un semplice ovale demo video (YouTube clip) 

  

 



Cos'altro posso fare con SCARM?  

� È possibile creare layout complessi con molte stazioni ferroviarie in aree grandi a piacere.  
� Si può modellare i binari flessibili tracciando le direzioni facilmente, in modo intuitivo e più importante - molto realistico.  
� È possibile distribuire il layout su più livelli, con diverse altezze e pendenze delle sezioni scelte dal percorso tracciato.  
� È possibile utilizzare gallerie e ponti (in corso di modifica).  
� È possibile disegnare figure al fine di creare gli edifici delle stazioni ferroviarie, case, industrie, ecc, insieme con tutte le 

necessarie strade e infrastrutture.  
� È possibile utilizzare semafori e segnali luminosi per creare la segnalazione del plastico.  
� Si può vedere una vista 3D del modello (in corso di modifica) - basta selezionare il tasto "3D" dalla barra degli strumenti nel 

menu principale.  
� È possibile misurare distanze e lunghezza delle sezioni di binari, utilizzando le funzioni del menu "Strumenti".  
� È possibile esportare e / o stampare il layout e mostrarlo agli appassionati fermodellisti.  
� È possibile visualizzare e stampare un elenco con i pezzi di binari necessari e persino usarlo come una lista della spesa.  
� È possibile condividere le tue idee con l'autore e chiedergli nuove caratteristiche e anche per la correzione di bug ed errori 

riscontrati.  

 

Domande e risposte (FAQ)  
 
  Dove sono le barre di scorrimento?! 
  Come funziona il Copia-Incolla? 
  Come spostare i binari? 
  Come scollegare e collegare i binari? 
  Come ruotare i binari? 
  Come selezionare una sezione? 
  Come spostare o girare una sezione? 
  Come fare per ingrandire? 
  Come lavorare con binari flessibili? 
  Come posizionare gallerie e ponti? 
  Come impostare le altezze e pendenze? 
  Come impostare i supporti al binario? 
  Come creare un elicoidale? 
  Come utilizzare il misuratore di distanze (Flessometro)? 
  Come impostare l'angolo di direzione del punto di partenza? 
  Come creare il piano di base? 
  Come si lavora con le figure in SCARM?  
  Come si creano i marciapiede di stazione?  
  Come si creano case ed edifici?  
  Come si mettono i segnali ferroviari?  
  Come si usa la casella degli strumenti?  
  Come controllare dimensioni e area del layout? 
  Come cambiare la biblioteca/marca dei binari? 
  Come ottenere i dettagli per la libreria selezionata? 
  Non riesco a trovare un particolare sistema/marca di binari nelle biblioteche? 
  Non riesco a trovare un binario particolare nel pannello di selezione binari? 
  Ci sono accessori mancanti o piattaforme girevoli, per i binari selezionati? 
  Come visualizzare un elenco di parti utilizzate? 
  Come stampare il layout progettato? 
  Posso usare SCARM da dispositivi di memoria portatili? 
  Ci sono versioni di SCARM per Mac o Linux? 
  Non riesco a trovare la risposta alla mia domanda? 

� Dove sono le barre di scorrimento?!  - Non ci sono barre di scorrimento. Per spostare il grafico, premere la rotella del 
mouse e trascinare la trama nella direzione desiderata. 
 

� Come funziona il Copia-Incolla?  - Funziona come al solito, nella maggior parte degli editor grafico vettoriali. I binari, posti 
negli appunti, appaiono su quelli che sono stati copiati. Dopo Incolla, è possibile spostare i binari che si desiderava copiare 
sul terreno. 
 

� Come spostare i binari?  - Tenere premuto Ctrl e trascinare i binari selezionati con il tasto sinistro del mouse o utilizzare il 
comando "Muovi" dal menu contestuale. 
 

� Come scollegare e collegare i binari?  - Ciò viene fatto automaticamente quando i binari vengono spostati. 
Disconnessione: seleziona il binario o tratto di binari, tenere premuto il tasto Ctrl e trascinarlo via con il pulsante sinistro del 
mouse. 
Connessione: selezionare il binario o tratto di binari, tenere premuto il tasto Ctrl e trascinarlo con il pulsante sinistro del 
mouse verso un altro binario, trattenere fino a che gli estremi si sovrappongono. Quando si sovrappongono, le frecce alle 
estremità del binario diventano di colore rosso e verde – si rilascia pulsante del mouse e i binari saranno collegati 
automaticamente. 
 

� Come ruotare i binari?  - Se si desidera inserire un nuovo binario, ruotato di un dato angolo o ruotare il tracciato esistente 



sulla trama, posizionare un nuovo Punto di partenza nella direzione desiderata e quindi posizionare il binario (o spostare il 
tracciato esistente) in quel punto. 
 
Se si vuole invertire il binario, è possibile farlo staccandolo e collegandolo nuovamente dal lato opposto (vedi risposta 
precedente per i dettagli). 
 

� Come selezionare una sezione?  - Sezione di binari è ogni percorso indipendente sul terreno. Selezionare il binario o un 
punto qualunque della sezione e selezionare "Modifica"> "Seleziona sezione" dalla barra dei menu. Oppure basta fare 
doppio clic con il pulsante sinistro del mouse sulla sezione desiderata. 
 

� Come spostare o girare una sezione?  - È possibile spostare o girare una sezione, esattamente come si muove o gira il 
binario singolo (vedi sopra). 
 

� Come fare per ingrandire?  - Usare "Visualizza" > "Scala" dal menu o "+" e "-" dal tastierino numerico della tastiera o 
semplicemente usare la rotellina del mouse. 
 

� Come lavorare con binari flessibili?  - Il binario flessibile (flex) ha lunghezza massima e il raggio minimo della curva di 
default. Si può modellare il percorso flessibile con molti tratti rettilinei e curve all'interno, ma il binario flessibile non può 
essere più lungo della lunghezza massima e non può essere curvato più del raggio minimo della curva. Se si vuole costruire 
un percorso più lungo usando il flessibile, utilizzare la barra spaziatrice per aggiungere nuovi binari flessibili, dopo aver finito 
con la modellazione del l'ultimo. 
 
Seleziona il binario flessibile dal pannello di sinistra - una guida diritta di colore grigio apparirà sulla trama con lunghezza 
massima possibile. Usate il mouse per formare una curvatura e la lunghezza della prima sezione - sarà disegnato in nero e 
la parte rimanente sarà disegnata in grigio. Fare clic sul pulsante sinistro del mouse per fissare la sezione e continuare con 
la parte rimanente. Fare clic sul pulsante destro del mouse per fissare la sezione e per "tagliare" la parte rimanente. Se non 
dovesse piacere la forma dell'ultima sezione fissa, è possibile eliminarla usando Backspace. Se si desidera annullare la 
modellazione, premere Esc. 
 
Modellazione di un binario flessibile demo video (YouTube clip) 
 

  
 

Se si desidera collegare il binario flessibile ad altri binari nel layout, puntare la restante parte grigia in direzione del 
l’estremità del binario, in modo che entrambi i binari si sovrappongono l'un l'altro - quando la direzione è diventata identica, 
la freccia del binario flessibile si colora in verde - fare clic sul pulsante sinistro del mouse per collegare i binari. 
 
Connessione di un binario flessibile demo video (YouTube clip) 
 

  
 

Per la modellazione precisa con parametri come lunghezza o raggio e l'angolo delle sezioni-flessibili, vedere la funzione 
"Modellazione Binari-Flessibili" nella Casella degli strumenti. 
 

� Come posizionare gallerie e ponti?  - Usare i tasti "Galleria"  o "Ponte"  dalla barra degli strumenti. Da quel punto 
in poi i binari saranno disegnati come in tunnel o il ponte, a seconda della modalità selezionata. Se si desidera modificare 
una parte del percorso tracciato, selezionarlo e poi selezionare la modalità preferita. 
 

� Come impostare le altezze e pendenze?  - Impostazione delle altezze e pendenze permette l'implementazione del 
percorso tracciato in più di un livello. Per iniziare a fare questo, passare "Visualizza" > "Visualizza altezza binari" dal menu. 
Le altezze saranno visualizzate alle estremità dei singoli binari ed i loro valori iniziali saranno zero nell’unità di misura 
selezionata. 

 
Per cambiare l'altezza (o la pendenza) del dato binario (o tratto di binario), prima di tutto deve essere selezionato il binario 
(o sezione) e allora si sarà in grado di selezionare l'altezza desiderata con il tasto sinistro del mouse. Non è possibile 
selezionare direttamente e cambiare altezze dei binari, che non sono selezionati. 

 
Utilizzare la rotellina del mouse oppure, '<' e '>' (tastiera USA/EN) o ',' e '.' (tastiera ITA) per impostare l'altezza selezionata. 
Tenere premuto Shift per cambiare con un passo più grande. Impostando l’altezza si formerà automaticamente la pendenza 
del binario o sezione selezionata. Il Gradiente verrà mostrato in percentuale con il colore, a seconda della lunghezza e 



l'angolo: fino al 2,5% - verde, fino al 4% giallo; oltre il 4% - rosso. I valori positivi rappresentano salite all'altezza selezionata, 
mentre i valori negativi sono per le discese. 

 
Tutti i tipi di binari possono avere altezze diverse, ma solo rettilinei, curve e flessibili possono formare rampe, perché solo 
loro possono avere altezze indipendenti su entrambe le estremità. Per impostare le altezze uguali per tutti i binari della 
sezione di binari selezionata, selezionare una qualsiasi altezza di esso, impostare il livello di altezza desiderata e premere 
Invio. Utilizzare il Visualizzatore 3D per vedere le differenti altezze nel layout - il programma automaticamente pone su 
supporti i binari con altezza maggiore di zero. 
 
Nota: A partire dalla versione 0.8.4, le pendenze verranno mostrate in percentuale di default. L'impostazione si trova in 
"Strumenti" > "Impostazioni..." > Scheda "Dimensioni" > "Sfumature", dove è possibile scegliere tra Percentuali (%) e 
migliaia (‰). La proporzione "percentuali / migliaia" è di 1:10, quindi 1% = 10 ‰. 
 

� Come impostare i supporti al binario?  - È possibile modificare o rimuovere i sostegni dei binari nella sezione selezionata 
o altezza selezionata, tramite i comandi "Modifica" > "Supporto binario" del menu. Le modifiche si riflettono solo in modalità 
di visualizzazione 3D. 
 

� Come creare un elicoidale?  - L’Elicoidale nel percorso tracciato, si utilizza quando c'è bisogno di superare un'altezza 
grande, che non può essere realizzata con semplice pendenza. Può essere creata con rotazioni diverse, collegando più 
pezzi di curve assieme e ultimo punto dell’ultimo settore sarà sollevato fino all'altezza desiderata. 
 
Prima di iniziare, verificare che il tasto altezza binario sia attivato e le altezze sono visibili sullo schermo - in caso contrario, 
passare "Visualizza" > "Visualizza altezza binari". Selezionare il punto di estremità, già esistente nel percorso e aggiungere 
la prima curva dell'elica lì. 

 
Premete la barra spaziatrice diverse volte fino a chiudere il cerchio che si è formato. Selezionare i binari nel cerchio, quindi 
selezionare l'altezza al punto libero estremo dell’ultima curva e cambiare l'altezza, in modo che la pendenza massima 
raggiunga il 4% - questo vi mostrerà l’altezza massima che si può superare con un singolo giro di elicoidale. 

 
Conoscendo questo valore e l'altezza di destinazione che si vuole raggiungere, si sarà in grado di ottenere il numero 
approssimativo di giri, necessari per la salita. Realizzare questi giri (di nuovo con barra spaziatrice), selezionare il cerchio 
(sempre con rettangolo di selezione), selezionare l'altezza nel punto di uscita dell’elicoidale e formare il gradiente finale e 
l'altezza della spirale. 

 
Valori di gradiente più grandi del 4% sono indesiderabili, perché le locomotive avranno molto carico in salita, specialmente 
con treni più lunghi e tenderanno a slittare. Gradi di pendenza inferiore al 3% potrebbero non essere adatti a causa del tipo 
di costruzione di supporto dell’elicoidale o per l'impiego di catenaria. Aggiungiamo l’ultimo binario di uscita, poi il tipo di 
supporto del binario di tipo Arco (usando "Modifica" > "Supporto binario" con il cerchio ancora selezionato) per un aspetto 
realistico. Potete vedere l'elicoidale nel visualizzatore 3D e poi fare le correzioni in altezza o nei giri (aggiungendo o 
rimuovendo binari curvi). 



 
Immagini del campione mostrano elica con altezza finale di 254 mm (10 pollici) in TT scala (1:120) 

 
Nota: Al momento non c'è alcun vantaggio nel fare Copia e Incolla negli elicoidali, perché quando ciò che abbiamo copiato si 
unisce a un'altra parte del percorso, le altezze dei binari all'interno sono equiparate e l’effetto elicoidale è perduto. 
 

� Come utilizzare il misuratore di distanze (Flessome tro)?  - Flessometro è uno strumento per misurare le distanze sul 
terreno di disegno. Per utilizzare il misuratore, è necessario attivare da "Strumenti" > "Flessometro". Fare clic con il pulsante 
sinistro del mouse nel primo punto di misura e trascinate il cerchio a distanza, fino a raggiungere il secondo punto di misura. 
La distanza viene visualizzata nella barra di stato. Per disattivare la modalità Flessometro, premere Esc. 
 

� Come impostare l'angolo di direzione del punto di p artenza?  - Tenere premuto il tasto sinistro del mouse mentre 
posizionando il punto di partenza, spostare il mouse nella direzione desiderata e rilasciare il pulsante quando è pronto. 
 
Vedere anche la funzione "Punto di partenza" nella Casella degli strumenti. 
 

� Come creare il piano di base?  - Selezionare "Modifica" > "Crea Piano di Base" dal menu e disegnare la forma del piano di 
base con il pulsante sinistro del mouse. Quando si è pronti per posizionare il punto, usare il pulsante destro del mouse per 
chiudere la forma. Se si desidera lavorare con precise linee orizzontali o verticali, tenete premuto Ctrl mentre si modella la 
forma (per le figure rettangolari). In realtà, la forma del piano può essere qualsiasi figura geometrica con l'unica limitazione 
che le parti non si possono attraversare l'un l'altro. 
 
Se si vuole cambiare la forma del piano, è possibile modificarlo o ricreare, usando la forma vecchia come base per la nuova 
figura. Modifica, è fatta con punti di controllo della forma alle estremità, che possono essere spostati, inseriti o cancellati. 
 
Se si desidera creare un piano di base rettangolare in tutto il percorso/layout esistente, tenere premuto Shift mentre si 
seleziona il comando "Crea Piano di Base". 
 
È inoltre possibile creare il vostro piano di base, inserendo le coordinate dei lati, utilizzando le funzioni dedicate nella 
Casella degli strumenti. 
 

� Come si lavora con le figure in SCARM?  - Le figure in SCARM vengono utilizzate per la creazione di forme 2D sulla 
trama del disegno, che poi diventano automaticamente degli oggetti 3D, con l'aggiunta di altezza e posizione verticale. Con 
l'aiuto delle figure, sarete in grado di creare edifici, marciapiedi di stazione, impianti ferroviari, attrezzature relative alla 
ferrovia, tutto quello che riguarda l'installazione ed il controllo del plastico e anche l'interno della stanza dove il plastico sarà 
situato. 
 
Per iniziare il vostro lavoro con figure in SCARM, aprire il menu di selezione biblioteca (facendo clic con il tasto destro del 
mouse sul nome della biblioteca attualmente selezionato, situato sulla parte superiore del pannello di selezione binari) e 
quindi selezionare "Figure" (in basso nell'elenco). I tipi di figure disponibili verranno visualizzati nel pannello. La modalità di 
selezione (primo pulsante) è attivata per impostazione predefinita. 
 
Al fine di disegnare una data figura, selezionare il pulsante nel pannello e seguire le istruzioni nella barra di stato. Quando la 
figura è pronta, il programma visualizzerà una finestra di proprietà, come mostrato qui sotto: 
 

 
 
Le funzioni dei campi sono come segue: 



 
Posizione verticale – questa è la distanza dal piano di base (quota zero) al fondo dell'oggetto 3D. 

Altezza – questa è l'altezza dell'oggetto 3D. Se il valore è zero, l'oggetto sarà invisibile nella modalità di visualizzazione 3D 
(utile per la marcatura delle regioni e aree specifiche nel layout, che sono visibili solo in modalità 2D). 

Colore – questo è il colore dell'oggetto. Fare clic sulla barra bianca per scegliere il colore desiderato dalla tavolozza di 
Windows. Se si fa clic sul piccolo pulsante, situato a destra della barra, la figura diventerà trasparente – può essere utile in 
alcune situazioni. 

Collega terreno al fondo – se selezionata, il terreno sotto la forma in modalità 3D sarà calamitato verso il fondo dell'oggetto. 
Se non è selezionato il riempimento, l'oggetto risulterà "galleggiante" (es. tetto o pensilina sopra marciapiede di stazione). 

All'interno del contorno - valida solo quando il campo superiore ha il check – se selezionata, il terreno sarà raccordato solo 
all'interno del contorno di figura (es. per la creazione di coste di fiumi e laghi). Se la casella non è selezionata, il riempimento 
del terreno si diffonderà fuori contorno della figura (es.per edifici). 
 
Fare clic su pulsante "3D" dalla barra degli strumenti per vedere la figura nel visualizzatore 3D. È possibile modificare le 
proprietà successivamente, selezionando la figura e aprendo la finestra Proprietà "Oggetti" > menu "Proprietà". È possibile 
lavorare con diversi oggetti allo stesso tempo – basta selezionarli con il rettangolo di selezione o da mouse, tenendo 
premuto il tasto Maiusc. Per modificare la forma di una figura già creata, fare clic con il mouse su di essa e modificare i punti 
di controllo. È possibile inserire nuovi punti facendo clic con il tasto destro del mouse, nel punto desiderato sul lato della 
figura e scegliere "Inserisci nuovo punto" dal menu contestuale. Se si desidera spostare qualche punto di controllo, 
selezionarlo e trascinare con il tasto sinistro del mouse in posizione desiderata, ma se si desidera rimuoverlo, selezionare il 
punto e premere il tasto Del. Si possono raggruppare diverse figure e lavorare con loro come singolo oggetto – basta 
selezionare le cifre e quindi attivare "Oggetti" > menu di "Gruppo". Per spostare un oggetto, prima selezionarlo, quindi 
tenere premuto Ctrl e spostarlo con il mouse o utilizzare il comando "Sposta" dal menu contestuale. Per ruotare un dato 
oggetto con un'angolazione diversa, utilizzare "Oggetti" > "Ruota" dal menu e impostare l'angolo nella finestra di rotazione 
utilizzando la barra di scorrimento orizzontale o le frecce. Per allineare molte figure orizzontalmente o verticalmente, 
utilizzare "Oggetti" > "Allinea" e regolare i pulsanti nella finestra di allineamento. 
 

� Come si creano i marciapiede di stazione?  - Selezioniamo figure nel pannello di selezione (ultima posizione nel menu 
dell'elenco librerie). Selezionare "Rettangolo" e disegnare il marciapiede tra i binari. Immettere l'altezza e il colore, nella 
finestra Proprietà e anche la posizione verticale, se i binari hanno altezza diversa da zero. Se i binari non sono esattamente 
orizzontali o verticali, è possibile ruotare la figura dell'angolo necessario, utilizzando: "Oggetti" > "Ruota" dal menu. Se i 
binari non sono dritti o se formano qualche angolo tra di loro, è possibile utilizzare "Poligono" per creare un marciapiedi di 
stazione di forma più complessa. 
 

� Come creare case ed edifici?  - È facile-basta sapere l'altezza necessaria, per il numero dei piani. Nell'esempio che segue, 
verrà creata una piccola casa di un piano. 
 
Abilitare le figure nel pannello di selezione (ultima posizione nel menu dell'elenco librerie). Selezionare "Rettangolo" e 
disegnare il corpo della casa. Immettere l'altezza della figura nella finestra Proprietà, secondo la vostra scala del modello. È 
possibile utilizzare i seguenti valori approssimati: 
 

 
Se il modello della costruzione ha un'altezza maggiore tra i piani o se la scala non è elencata nella tabella, è possibile 
calcolare l'altezza necessaria in scala dalla formula Altezza reale / Scala. Dopo aver calcolato l'altezza, immettere il valore 
ottenuto, impostare rimanenti campi nella finestra Proprietà (se necessario) e chiudere la finestra. Selezionare il rettangolo 
(cliccando con il mouse su di esso) e selezionare il pulsante con la figura del "Tetto" dal pannello di selezione. Selezionare il 
tipo di tetto e il primo edificio creato con SCARM è pronto. 
 

 

Altezza reale di un piano Scala Formula Altezza in scala di un 
piano

3m = 3000 mm 
10ft = 120" 
 
utilizzare i valori nel vostro sistema di misura 
preferito

G (1:22.5)
3000 / 
22.5 
120 / 22.5

133.33 mm 
5.333"

I (1:32) 3000 / 32 
120 / 32

93.75 mm 
3.75"

OO (1:76) 3000 / 76 
120 / 76

39.47 mm 
1.579"

HO (1:87) 3000 / 87 
120 / 87

34.5 mm 
1.379"

TT 
(1:120)

3000 / 120 
120 / 120

25 mm 
1"

N (1:160) 3000 / 160 
120 / 160

18.75 mm 
0.75"

Z (1:220) 3000 / 220 
120 / 220

13.64 mm 
0.545"



Una piccola casa con tetto a padiglione 
 
Al fine di ottenere un 3D più realistico, guarda, casa tua necessita una porta e delle finestre. Per crearli, prima occorre 
rimuovere il tetto (selezionando la figura del tetto ed eliminandolo). È possibile ingrandire il disegno per un funzionamento 
più facile e preciso (utilizzando il menu "Visualizza" > "Scala" > "Zoom+"). Ora aggiungiamo una nuovo rettangolo sopra la 
linea di fondo del rettangolo principale, vicino l'angolo a sinistra. Inseriamo l'altezza per essere a 3/4 di altezza del nostro 
piano in scala e scegliamo il colore marrone nella finestra da Proprietà, perché questa sarà la porta di casa. Larghezza 
(orizzontale sulla trama) deve essere la larghezza della porta nella scala ferroviaria che utilizziamo, ma la profondità 
(verticale sulla trama) deve essere minima. Il nuovo rettangolo (porta) deve essere collocato poco al di fuori del rettangolo 
principale (casa), altrimenti la porta sarà invisibile nella modalità di visualizzazione 3D. La figura che avete sullo schermo 
sarà più o meno come questa: 
 

 
 
Ora creiamo un nuovo rettangolo a destra, accanto al rettangolo della porta e impostiamo la posizione verticale in modo che 
sia tra 1/2 ed 1/3 dell'altezza del nostro piano in scala ridotta. Il colore può essere blu profondo o nero, questa sarà la prima 
finestra. Non dimenticate che questo rettangolo finestra deve stare sulla linea di fondo del rettangolo principale e poco al di 
fuori di essa (come la porta). La figura sullo schermo sarà più o meno come questa: 
 

 
 
Aggiungiamo una seconda finestra allo stesso modo, ma ora posizionata verticalmente sul lato destro del rettangolo 
principale. Impostate le stesse proprietà, come per la prima finestra. Selezionare il rettangolo principale e aggiungere un 
nuovo tetto. Ora la casa nella modalità di visualizzazione 3D sarà simile all'immagine seguente: 
 

 
 
È possibile creare edifici multipiano con il copia-incolla dei rettangoli finestra al piano di base e alterando la posizione 
verticale per la selezione, incrementandola con l'altezza di un piano in scala. Si può fare più volte con tutti i rettangoli di 
finestra per raggiungere tutti i necessari piani. Non dimenticate di aumentare l'altezza dell'edificio, altrimenti le finestre 
"voleranno" sopra l'edificio nella modalità di visualizzazione 3D. Potete creare un edificio o stazione con molte ali utilizzando 
dei rettangoli diversi per ogni ala. Dopo il completamento dell'edificio complesso con tutte le porte, finestre e tetto, 
selezionare tutte le parti con il rettangolo di selezione e raggrupparle in un singolo oggetto utilizzando "Oggetti" > menu di 
"Gruppo". Ora sarete in grado di lavorare in modo più facile e confortevole con l'edificio sulla trama del disegno, posizionarlo 
e ruotarlo nel luogo desiderato. Guardate alcuni edifici e altre cose, create in questo modo con SCARM nelle immagini qui 
sotto: 
 

  

Casa con due piani e loft   Edificio amministrativo con parcheggio

  



 
� Come si mettono i segnali ferroviari?  - In SCARM i segnali ferroviari sono oggetti predefiniti nelle speciali librerie degli 

Oggetti, che possono essere selezionate come le librerie dei normali binari, dal menu selezione biblioteca. Essi possono 
esistere nella biblioteca di uno specifico produttore (in scala fissa) o possono essere universali (generico). I segnali generici 
sono utili nella definizione del layout, quando i segnali del modello reale non sono disponibili nella libreria del costruttore 
dedicato o quando i segnali sono autocostruiti da voi o altri appassionati di segnalazione ferroviaria. 
 
Iniziamo con segnali, prima selezioniamo la libreria desiderata dall'elenco librerie – le librerie degli oggetti, si trovano nel 
sottomenu, denominato "Oggetti" (ultima voce nel menu librerie). Ingrandite l'area, dove si desidera posizionare il segnale. 
Selezionate il segnale necessario dal pannello di selezione – il segnale apparirà al centro dello schermo. Se la libreria è 
generica, il segnale verrà riscalato per la scala della biblioteca dell'ultimo binario usato. Selezionate l'oggetto sullo schermo 
con il mouse e utilizzate "Oggetti" > "Ruota" dal menu, per ruotare il segnale nella direzione desiderata, lungo il tracciato. 
Tenete premuto Ctrl e spostate l'oggetto con il mouse nella posizione desiderata. Quando è tutto pronto, si vede come il 
segnale apparirà sul layout facendo clic sul pulsante "3D" dalla barra degli strumenti. 
 
Nota: Solo alcuni segnali base di alcune amministrazioni ferroviarie in tutto il mondo sono disponibili al momento. Altre 
librerie di segnali arriveranno presto. 
 

� Come usare la casella degli strumenti?  - La casella degli strumenti in SCARM è una piccola finestra di supporto, che può 
rimanere aperta e sempre in cima, destinata ad aiutare la creazione, progettazione e posizionamento preciso dei differenti 
elementi sulla trama del disegno. Utilizzare "Strumenti" > menu "Strumenti" per attivare la casella degli strumenti e quindi 
selezionare uno strumento dall'elenco a discesa all'interno. Segue una breve descrizione delle diverse funzioni di seguito. 
 
Punto di partenza: destinato al posizionamento preciso del punto iniziale. Immettere le coordinate nei campi X e Y, l'angolo 
di direzione nel campo A e premere il pulsante "Piazzare". 
 
Piano di base (rettangolare): Serve a creare un piano con forma rettangolare. Immettere le lunghezze dei lati nei campi A - 
B e premere il pulsante "Fatto". 
 
Piano di base (coordinate ass.): destinato a creare il piano di base inserendo le coordinate assolute dei lati. Inserire l prima 
coordinata nei campi x e y, premere il pulsante verde [+]. Immettere le coordinate rimanenti allo stesso modo (la forma del 
piano di base sarà aggiornata dopo ogni pressione del pulsante[+]), premere "Fatto" quando è tutto pronto. Se si immette un 
valore errato, cancellarlo premendo il tasto rosso [-]. Esempio 
 
Piano di base (spostamenti): destinato a creare il piano di base inserendo le coordinate relative dei lati. In questo caso, la 
prima coordinata assoluta è il punto di partenza e ogni successiva coordinata è l'offset relativo rispetto il precedente punto a 
dx (orizzontale) e valori dy (verticale). Inserite il punto iniziale (assoluto) nei campi dx e dy e premere il pulsante verde [+]. 
Immettere l'offset delle coordinate rimanenti nello stesso modo (la forma del piano di base sarà aggiornata dopo ogni 
pressione del pulsante [+]) e premere "Fatto" quando è pronto. Se si immette un valore errato, cancellarlo premendo il tasto 
rosso [-]. Esempio 
 
Modellazione Binari-Flessibili: destinato per la sagomatura precisa dei binari flessibili inserendo i parametri di ogni sezione. 
La modellazione delle sezioni puo essere eseguita con il mouse e dalla casella degli strumenti. Iniziate con la selezione e il 
posizionamento del binario flessibile dal pannello di selezione binari. Il flessibile seguirà il cursore, mentre si sta muovendo il 
mouse sulla trama del disegno – non preoccupatevi di questo. Per aggiungere un tratto rettilineo, immettere la lunghezza 
desiderata nel campo l e premere il pulsante "+ dritto" . Per aggiungere una sezione ricurva, immettere il raggio desiderato 
nel campo r e l'angolo di curvatura nel campo A, quindi premere il pulsante "+ curva". Se il raggio inserito è più piccolo del 
raggio minimo ammesso per il binario flessibile, la sezione verrà aggiunta con il raggio minimo possibile. Un angolo positivo 
dà la curva a destra, mentre uno negativo viene utilizzato per la curva sinistra dalla direzione corrente. Se l'ultima sezione 
aggiunta non è adatta, è possibile eliminarla premendo il pulsante rosso piccolo [-]. Quando la forma del flessibile è pronta, 
premere il pulsante "Difficoltà". Se l'ultima sezione aggiunta è più lunga della rimanente parte di binario, questo verrà 
corretto automaticamente. 
 

� Come controllare dimensioni e area del layout?  - Tasto "Visualizza" > "Guarda area" dalla barra dei menu. 
 

� Come cambiare la biblioteca/marca dei binari?  - Clicca con il tasto destro del mouse sul nome della libreria 
correntemente selezionata (che si trova sulla parte superiore del pannello di selezione dei binari) - un elenco con le librerie 
apparirà. 
 

� Come ottenere i dettagli per la libreria selezionat a? - Spostare il puntatore del mouse sul nome della biblioteca 
selezionata - un suggerimento a tendina con le proprietà della biblioteca attiva apparirà. 

Stazione ferroviaria con ristorante   Stazione ferroviaria con sala controllo e deposito



 
� Non riesco a trovare un particolare sistema/marca d i binari nelle biblioteche?  - le librerie disponibili sono descritte qui. 

Una libreria contrassegnata come "nuovo" deve essere scaricata, decompressa, ed il file. Lib si deve inserire nella cartella 
Lib del programma per essere disponibile per l'utilizzo. L'autore sarà molto grato per qualsiasi informazione o 
aggiornamento sui produttori dei binari, le loro dimensioni e la geometria del sistema di binari. 
 

� Non riesco a trovare un binario particolare nel pan nello di selezione binari?  - Scorrere i binari nel pannello usando la 
rotellina del mouse, perché alcuni dei binari possono essere ubicati fuori della zona visibile. E 'possibile che il binario 
cercato non è incluso nella libreria (per esempio, se è nuovo articolo o se è mancato per l'autore). 
 

� Ci sono accessori mancanti o piattaforme girevoli, per i binari selezionati?  - Al momento solo alcuni accessori sono 
inclusi in alcune delle librerie. Questo processo richiede molto lavoro e ci vorrà del tempo, fino a quando tutte le librerie 
saranno completate con tutti gli accessori possibili. 
 

� Come visualizzare un elenco di parti utilizzate?  - Selezionare "Strumenti" > "Lista di binari" dal menu. L'elenco verrà 
visualizzato nel browser predefinito da dove può essere salvata o stampata. 
 
Nota: I progetti, creati e salvati con versioni precedenti alla 0.6.0 non contengono informazioni su scala, binario e produttore. 
 

� Come stampare il layout progettato?  - Stampa con SCARM è facile - vedere le possibili vie di seguito. 
 
Se si desidera stampare l'intero layout, è sufficiente premere il pulsante "Stampa" nella barra degli strumenti - il programma 
adatta automaticamente l'itinerario tracciato nella pagina e lo stampa sulla stampante predefinita. 
 
Se volete vedere la pagina con il layout della ferrovia prima della stampa, premere il tasto "Anteprima di stampa", nella barra 
degli strumenti - questo attiverà la modalità Anteprima di stampa. 
 
Se si desidera stampare parte del percorso tracciato, assicurarsi che la modalità anteprima di stampa sia attiva (deve 
essere selezionato "Visualizza" > "Guarda Anteprima di stampa"), spostare e / o ridimensionare il disegno per ottenere il 
layout desiderato parte in vista e poi premere il tasto "Stampa" - SCARM stamperà la pagina esattamente come viene 
visualizzata sullo schermo. Ricordate che è possibile modificare il progetto e tutte le altre cose, non importa se si lavora in 
modalità normale o in modalità Anteprima di stampa. 
 
Se si apportano modifiche durante il lavoro in modalità Anteprima di stampa, per cui l'orientamento del layout non è più 
ottimale, passare al largo e poi di nuovo "Visualizza" > "Guarda Anteprima di stampa" - SCARM imposterà l'orientamento 
della pagina in base all'orientamento del layout corrente. Premere il pulsante "Adatta allo schermo" dalla barra degli 
strumenti, se si vuole adattare il layout della pagina. In realtà, il pulsante spegnimento dell "Anteprima di stampa" fa la 
stessa cosa per voi. 
 
Se si desidera un controllo preciso del processo di stampa, selezionare "File" > "Stampa..." e impostare le opzioni 
desiderate nella finestra di dialogo di stampa. 
 
Nota: Se il layout ha un piano di base e ci sono binari al di fuori dei contorni, le tracce non saranno prese in considerazione 
quando SCARM calcola la posizione e le dimensioni del layout nell'area stampabile. 
 

� Posso usare SCARM da dispositivi di memoria portatili?  - Sì, è possibile eseguire SCARM da dispositivi portatili, come 
le memorie USB. Per fare questo, copiare la cartella di installazione del programma (di default è C:\Program Files\SCARM) 
al dispositivo di memoria rimovibile desiderato ed eseguire scarm.exe da quel dispositivo. Quindi aprire "Strumenti" > 
"Impostazioni" e passare alla pagina "Portatile" nella finestra di dialogo Impostazioni. Premere il tasto "Salva impostazioni 
localmente" e confermare la cartella, copiata sul dispositivo portatile. Ora, quando SCARM verrà lanciato dal dispositivo 
portatile, ricorderà le impostazioni su quel dispositivo. 
 

� Ci sono versioni di SCARM per Mac o Linux?  - No. SCARM è disponibile solo per Windows. 
 

� Non riesco a trovare la risposta alla mia domanda?  - Contatta l'autore a  (in lingua inglese). 

Verificare la presenza di notizie, video, consigli, trucchi e altro su SCARM nelle pagine dedicate SCARM Blog, Twitter, 
YouTube e Facebook. 

 

 

Problemi noti  

� Istantanee vuote nella modalità di visualizzazione 3D – a causa di alcune incompatibilità tra il motore di rendering 3D di 
SCARM e alcuni driver/schede grafiche, è possibile che i file snapshot 3D siano vuoti. 
 
Soluzione possibile: selezionare "Visualizza" > "Schermo intero" dal menu quando, siamo in visualizzazione di modalità 3D 
e quindi premere "Print Screen", premere il tasto della tastiera (PrScr) - la scena verrà copiata negli Appunti. Premere Esc 
per tornare in schermo normale. Aprire alcuni editor grafico (come MS Paint), incollare lo schermo e salvarlo in un file.  

Ricordate, che SCARM è ancora in fase beta di sviluppo e a volte potrebbe non funzionare come previsto. Create sempre archivi 
del vostro plastico e salvate le modifiche nei file con nomi incrementali (solo in caso di malfunzionamento) vale a dire 
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"layout_1.scarm", "layout_2.scarm" e così via. Si prega di segnalare eventuali bug e messaggi di errore con spiegazione di: come, 
quando e dove nel programma si verifica all'autore a  (in lingua inglese). 

 

Link utili  
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SCARM - The Railway Modeller's Blog - Even More About SCARM

RailServe.com - The Internet Railroad Directory

ModelRailroads.net - Model Railroad Resource Directory

ScaleModel.net - International list of scale model related web sites
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